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1. Sicurezza e responsabilità

1.1. Precauzioni di sicurezza e di utilizzo
Le presenti istruzioni per l’uso contengono importanti informazioni sulla sicurezza, l’uso e la 
manutenzione del visualizzatore Equotip 3. Leggere attentamente le istruzioni per l’uso prima 
di utilizzare lo strumento. Conservare le istruzioni per l’uso in un luogo sicuro per poterle con-
sultare in qualsiasi momento.

1.2. Responsabilità e garanzia
Le «Condizioni generali di vendita e di consegna» di Proceq possono sempre essere applicate. 
Le pretese di garanzia derivanti da lesioni personali o danni alla proprietà non sono accettate 
se derivanti da una delle seguenti cause:
•	 utilizzo dello strumento non in conformità con l’uso a cui è destinato come descritto nelle  
	 presenti istruzioni per l’uso.
•	 controllo impreciso delle prestazioni di funzionamento e manutenzione dello strumento e  
	 dei relativi componenti.
•	 mancato rispetto delle disposizioni sul controllo delle prestazioni, sul funzionamento e sulla 
	 manutenzione dello strumento e dei relativi componenti riportate nelle presenti istruzioni  
	 per l’uso.
•	 modifiche strutturali non autorizzate dello strumento e dei relativi componenti.
•	 gravi danni prodotti da corpi estranei, incidenti, vandalismo e forza maggiore.
Tutte le informazioni contenute nella presente documentazione sono date in buona fede e con 
la presunzione della loro correttezza. Proceq SA non fornisce alcuna garanzia ed esclude ogni 
responsabilità riguardo alla completezza e/o all’accuratezza di tali informazioni.

1.3. Indicazioni di sicurezza
Lo strumento non può essere utilizzato da bambini o da persone sotto l’effetto di alcool, dro-
ghe o farmaci. L’utilizzo dello strumento da parte di persone che non hanno familiarità con le 
presenti istruzioni deve essere controllato.

1.4. Simboli
I seguenti simboli sono utilizzati in combinazione con tutte le principali indicazioni di sicurezza 
inserite nelle presenti istruzioni per l’uso.

Pericolo:
Il simbolo indica un rischio di gravi ferite o un rischio di morte nel caso che non 
si tenesse conto di alcune regole di comportamento.

i
Nota:
Il simbolo indica importanti informazioni utili.
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2. Teoria della prova di durezza con rimbalzo Leeb

2.1. Principio della prova
Durante la misura con i percussori Equotip 3 (D, DL, DC, C, G, S, E), un corpo di battuta con 
penetratore sferico è lanciato con forza dinamica contro il campione da misurare e rimbalza. 
Prima e dopo l’impatto, un magnete permanente integrato al corpo di battuta passa attraverso 
una sonda in cui viene indotto un segnale V ad alta tensione con un movimento avanti e indietro.  
Il movimento del segnale di induzione è proporzionale alla velocità. Il valore di durezza HL  
(durezza Leeb) risulta dal rapporto fra la velocità di rimbalzo vr e la velocità d’impatto vi molti-
plicato per 1000. HL è una misura diretta di durezza.

2.2. Preparazione del campione
Il campione deve essere esente da vibrazioni durante la prova. Le parti leggere e sottili devono 
essere fissate in modo particolare (vedi capitolo 2.6. «Prova di campioni leggeri»). Verificare 
che la superficie del pezzo sia pulita, asciutta e liscia. Se necessario, usare un detergente 
adatto per la pulizia, p.es. acetone o isopropanolo (non acqua!).

2.3. Condizioni di prova

Tipo di percussore
Peso minimo del campione

Campione di forma 
compatta

Campione appoggiato su 
una base solida

Accoppiato a una 
solida base

C 1,5 kg (3,3 libbre) 0,5 kg (1,1 libbre) 0,02 kg (0,045 libbre)
D, DC, DL, S, E 5 kg (11 libbre) 2 kg (4,5 libbre) 0,1 kg (0,25 libbre)
G 15 kg (33 libbre) 5 kg (11 libbre) 0,5 kg (1,1 libbre)

Tipo di percussore
Spessore minimo del campione

Non accoppiato Accoppiato Spessore della 
superficie

C 10 mm (2/5 pollice) 1 mm (1/25 pollice) 0,2 mm (8 µpollici)
D, DC, DL, S, E 25 mm (1 pollice) 3 mm (1/8 pollice) 0,8 mm (32 µpollici)
G 70 mm (2 pollici) 10 mm (2/5 pollice) n.d.

Tipo di percussore
Condizioni della superficie del campione

Classe di rugosità 
ISO

Profondità massima di 
rugosità Rt

Profondità media di 
rugosità Ra

C N5 2,5 µm (100 µpollici) 0,4 µm (16 µpollici)
D, DC, DL, S, E N7 10,0 µm (400 µpollici) 2 µm (80 µpollici)
G N9 30,0 µm (1200 µpollici) 7,0 µm (275 µpollici)

Tipo di percussore Durezza massima del campione
in HL in HRC in HV in HB

G 750 HLG n.d. ~ 675 HV ~ 645 HB
D, DC 890 HLD ~ 68 HRC ~ 955 HV n.d.
DL 950 HLDL ~ 68 HRC ~ 955 HV n.d.
C 960 HLC ~ 70 HRC ~ 1010 HV n.d.
S 890 HLS ~ 70 HRC ~ 965 HV n.d.
E 855 HLE ~ 72 HRC ~ 1200 HV n.d.

Tipo di percussore Distanza minima
fra le penetrazioni fra penetrazione e spigolo del campione

C 2 mm (1/12 pollice) 4 mm (1/6 pollice)
D, DC, DL, S, E 3 mm (1/8 pollice) 5 mm (1/5 pollice)
G 4 mm (1/6 pollice) 8 mm (1/3 pollice)



© 2013 by Proceq SA  	        6

2.4. Selezione del tipo di percussore Equotip corretto
Per una prova ottimale di diversi materiali metallici e della geometria di campioni, sono  
disponibili i seguenti tipi di percussori:

Tipo Utilizzo Energia  
d’impatto

D Unità universale. 
Per la maggior parte delle esigenze di prova della durezza.

11 Nmm

G Energia d’impatto aumentata. 
Per componenti solide, p.es. pezzi colati e forgiati duri.

90 Nmm

DL Sezione frontale sottile. 
Per misure in spazi ristretti, alla base di scanalature o su super-
fici incassate.

11 Nmm

E Penetratore con sfera a diamante. 
Per misure speciali in campi di durezza estremamente elevati 
(sempre superiori a 50 HRC/650 HV): acciaio da utensili con alto 
tenore in carburo.

11 Nmm

S Penetratore con sfera ceramica.
Per misure in campi di durezza molto elevati (sempre superiori a 
50 HRC/650 HV): acciaio da utensili con alto tenore in carburo.

11 Nmm

C Energia d’impatto ridotta. 
Componenti indurite superficialmente, rivestimenti, componenti 
sottili o sensibili agli urti (scarsa penetrazione).

3 Nmm

DC Strumento corto. 
Per spazi estremamente ridotti, p.es. in fori, cilindri o misure 
interne su macchinari montati.

11 Nmm

SVP 
40

Sonda.
Strumento semiautomatico per la valutazione rapida della sede e 
della regolarità di avvolgimenti statorici.

28 Nmm

i
Nota: Per i percussori Equotip 2 ed Equotip 3, il visualizzatore Equotip 3 ricono-
sce automaticamente il tipo di strumento. Se si collega un percussore di vecchia 
generazione, un menu di selezione si apre per definire il tipo di strumento corretto.

i
Nota: Il percussore DL può essere utilizzato unicamente con la correzione ma-
nuale della direzione d’urto.

2.5. Procedura di prova

•	 Premere  per circa due secondi per accendere lo strumento.
•	 Selezionare «Bar graph» (Grafico a barre) o «Basic mode» (Modalità di base) dal menu  
	 «View» (Vista) (vedi capitolo 5.1. «Viste»).
•	 Selezionare la compensazione automatica della direzione d’urto [«a Automatic»  
	 (a automatica)] premendo F1 (vedi capitolo 6.1. «Impostazioni»). Se non è possibile  
	 selezionare «a», definire la direzione d’urto (    ).
•	 Selezionare il gruppo di materiali a cui appartiene il campione da provare premendo F2  
	 (vedi il capitolo 6.2. «Gruppi di materiale»).
•	 Selezionare la scala di durezza da visualizzare premendo F3 (vedi il capitolo 6.3.  
	 «Scale di durezza»).
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•	 Selezionare il numero di impatti n per le serie di misure premendo F4  
	 (vedi il capitolo 6.4. «Numero di impatti per serie di misure»).
•	 Per eseguire la prova utilizzare la sequenza «1. caricamento – 2. posizionamento –  
	 3. misura»:

1.	 Per caricare il percussore quando non è a contatto con il campione, tenere saldo 
lo strumento con una mano e far scorrere con l’altra il cilindro di caricamento fino a 
sentire il contatto.

2.	 Posizionare la testina d’urto sul pezzo da provare. Prestare particolare attenzione a 
far aderire completamente la testina d’urto sul campione, ma senza farlo coincidere 
con il segno di una precedente prova.

3.	 Per attivare l’impatto, premere il tasto per liberare il corpo di battuta. Ripetere 
l’operazione per effettuare una nuova prova.

•	 Dopo l’ultimo n impatto vengono visualizzate la durezza media e altre statistiche della serie  
	 di misure.

i
Nota: Il percussore DL può essere utilizzato unicamente con la correzione ma-
nuale della direzione d’urto.

i
Nota: Verificare che il cilindro di caricamento ritorni lentamente nella posizio-
ne di partenza. Prestare particolare attenzione a non fare ritornare il cilindro di  
caricamento in modo incontrollato in quanto potrebbe danneggiare permanen-
temente lo strumento.

i
Nota: Se possibile, seguire la prassi standard delle prove di durezza a rimbalzo, 
come descritto nelle norme nazionali DIN 50156-1 (materiali metallici) o ASTM 
A956 (solo per acciaio, acciaio fuso e ghisa). Se non è possibile, si raccomanda 
di effettuare almeno da 3 a 5 impatti a intervalli di 3-5 mm (0,12-0,20 pollici) in 
ogni zona da misurare e di usare la media dei singoli valori.

i
Nota: Non effettuare impatti in zone già deformate da un impatto precedente. 
Inoltre, non caricare il dispositivo quando è già posizionato nella nuova zona di 
prova, in quanto il materiale sotto il dispositivo può subirne la sollecitazione e la 
pinza di presa dello strumento potrebbe danneggiarsi. Il movimento di carica-
mento può essere effettuato dopo un impatto (prima di cambiare posizione) o in 
una posizione che non si intende provare in seguito.

2.6. Prova di campioni leggeri
Se i campioni sono più leggeri di quanto specificato nel capitolo 2.3. «Condizioni di prova»  
(1,5 / 5 / 15 kg) o se le sezioni dei campioni presentano una distribuzione inadeguata del-
la massa, i campioni possono subire vibrazioni quando il corpo di battuta colpisce il punto di  
prova. Ciò si traduce in un assorbimento di energia indesiderato che falsa il risultato della prova. 
Pertanto, questi campioni devono essere sempre sostenuti da solide superfici di appoggio. Se la 
massa è inferiore a 0,5 / 2 / 5 kg, ma superiore a 0,02 / 0,1 / 0,5 kg, può essere utile «accoppiare» 
il campione a una massa superiore per prevenire le vibrazioni, laddove è garantito un fissaggio 
rigido al supporto. I seguenti requisiti devono essere soddisfatti per l’accoppiamento:
•	 la superficie di contatto del campione e la superficie di appoggio devono essere piane e lisce
•	 il campione deve avere uno spessore superiore a quello minimo richiesto per  
	 l’accoppiamento (1 / 3 / 10 mm). 
Procedere come segue per l’accoppiamento:
•	 applicare uno strato fine di pasta di accoppiamento sulla superficie di contatto del campione
•	 premere saldamente il campione contro il supporto
•	 sfregare il campione contro il supporto con un movimento circolare. 
	 Effettuare l’impatto come d’uso, perpendicolarmente alla superficie accoppiata.
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i
Nota: il fissaggio potrebbe incrudire il campione con un alterazione delle prove 
di durezza.

2.7. Prova di superfici curve
Lo strumento lavora correttamente solo se il penetratore sferico sulla parte frontale del corpo di 
battuta si trova esattamente all’estremità del tubo al momento dell’impatto. Se si provano delle 
superfici concave o convesse, il penetratore sferico non abbandona in modo sufficiente il tubo 
o esce troppo. In questi casi, riposizionare la testina d’urto standard su un supporto speciale 
per effettuare la prova (vedi «Accessori» o contattare il rivenditore Proceq di zona).

2.8. Prova di campioni con pareti sottili (p.es. campioni tubolari e tubi)
I tubi sovente hanno una distribuzione inadeguata della massa che influisce sul risultato della 
prova di durezza Leeb. Nella maggior parte dei casi, ciò è dovuto a delle vibrazioni indotte 
quando il corpo di battuta colpisce il punto di prova e si traduce in un assorbimento di energia 
indesiderato. Durante la prova in cantiere dei tubi per esempio il campione non può essere 
posato su un supporto solido o fissato.
Per beneficiare della praticità e della rapidità della prova Leeb, si può utilizzare una conversione 
personalizzata dopo aver effettuato la seguente procedura di calibratura:
•	 le coppie di dati sono misurate su campioni di riferimento. Per le misure di riferimento Leeb 
	 HLDL è estremamente importante eseguirle su parti installate allo stesso modo che quelle  
	 da provare sul cantiere. Per esempio, due campioni di tubi «tubo tipo 123 morbido»  
	 (730 HLDL / 255 HB) e «tubo tipo 123 duro» (770 HLDL / 310 HB) sono misurati  
	 rispettivamente con un percussore Equotip 3 DL e un Brinell.
•	 La curva di conversione originale HLDL-HB per «1 Acciaio e acciaio fuso» è ora  
	 adattata tramite i due punti di dati. La procedura dettagliata per creare curve di  
	 conversione personalizzate in Equotip 3 è descritta nel capitolo 7.1. «Curve di conversione  
	 personalizzate».
•	 Per misurare in futuro i tubi di tipo 123, tramite il gruppo di materiale è possibile selezionare 
	 «Customer defined» (Personalizzato) – «Pipe type 123» (Tubo tipo 123) utilizzando la scala  
	 di durezza «HB Brinell».
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i
Nota: È necessario determinare e qualificare l’adattamento della curva di con-
versione per ogni diametro di tubo e spessore di parete. Guide per procedere 
sono disponibili in Nordtest Technical Report Series 424, Reports 99.12/13 e 
ASME Final Report CRTD-91.

3. Vista d’insieme dell’Equotip 3
Equotip 3 è di regola utilizzato per provare la durezza di superfici metalliche. Lo strumento 
misura la durezza Leeb HL applicando il metodo di rimbalzo Leeb. Grazie al suo design com-
patto, le misure possono essere effettuate rapidamente, sul posto e in qualsiasi posizione e 
direzione. Fornisce la conversione della durezza HL determinata in diverse scale di durezza 
quali Brinell (HB), Vickers (HV), Rockwell (HRB, HRC) e Shore (HS) come pure nella resistenza 
alla trazione (Rm).

3.1. Esempi di applicazione
•	 Prove di durezza interamente documentate su macchine già assemblate o su costruzioni  
	 in acciaio e in getto come pure su piccole parti e geometrie di parti difficili
•	 Prove di pezzi metallici lavorati se la deformazione deve essere minima
•	 Misure di controllo della qualità per una rapida determinazione di una particolare  
	 condizione di trattamento termico
•	 Prova rapida di punti di misura al fine di esaminare il cambio di durezza su vaste zone
•	 Applicazioni di prova automatizzate.

Pericolo: Altre applicazioni potrebbero essere pericolose. Il fabbricante non è 
responsabile dei danni causati da uso improprio o funzionamento non corretto.

3.2. Versioni del prodotto, componenti e accessori

Visualizzatore Equotip 3
•	 Strumento con tutte le funzioni per la prova della durezza (statistiche ampliate incluse)
•	 Ampia memoria per la memorizzazione di ~ 100 000 valori di misura
•	 Configurazione di profili utente con impostazioni personalizzate
•	 Comunicazione con il PC o stampa dei dati direttamente via USB, ethernet o RS 232
•	 Software Equolink 3 PC per documentare le prove

Equotip 3 con percussori Equotip 3
•	 Prove ottimizzate di diversi materiali metallici e geometrie di campioni utilizzando una  
	 vasta gamma di percussori
•	 Prove nelle scale di durezza Leeb originali con massima precisione e ripetibilità
•	 Conversione della durezza in diverse scale (HRC, HRB, HRA, HV, HB, HS) e resistenza  
	 alla trazione per l’acciaio (Rm)
•	 Prova di materiali speciali mediante conversione di durezza personalizzate

Equotip 3 con sonda SVP 40
•	 Percussore semiautomatico
•	 Verifica e valutazione rapide del cuneo di avvolgimenti statorici, p.es. della sede e della  
	 regolarità, oppure dell’omogeneità della durezza di metalli

Pacchetto di automazione Equotip 3
•	 Controllo a distanza del visualizzatore Equotip 3
•	 Integrazione delle prove di durezza nel sistema di gestione della qualità e in ambienti di  
	 prova (semi)automatici
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Blocchi di prova Equotip
•	 Verificare il corretto funzionamento dei percussori Leeb su blocchi di prova calibrati con  
	 le scale Leeb originali

3.3. Vista d’insieme dello strumento

1 Visualizzatore Equotip 3

2 Percussore Equotip

3 Cavo del percussore Equotip

4 Porte di collegamento

5 LED di stato

6 Tasto accensione / spegnimento

7 Schermo LCD

8 Tastiera

9 Compartimento per batteria

1 Apre i menu e l’aiuto  
(se il mouse è collegato)

2 Data e ora
3 Memorizzazione automatica

4 Tipo di percussore collegato

5 Stato per stampa / ethernet / 
collegamento USB

6 Indicatore del livello della 
batteria

7 Impostazioni del limite  
inferiore e superiore

8 Visualizzazione di valore medio 
/ ultima prova

9 Prove fuori limite
10 Direzione d’urto
11 Gruppo di materiale
12 Scala di durezza

13 Numero di prove di durezza per 
serie

14 Nome del file della serie di 
misure

15 Tasti per la navigazione attivi

16 Funzione dei tasti di navigazio-
ne nel contesto attuale



© 2013 by Proceq SA  	        11

 
1 RS 232 per la stampante

2 Presa ventipolare per  
percussori Equotip

3
USB 1.1 tipo A (master) per ta-
stiera, mouse, lettore di codice 
a barre, stampante

4 USB 1.1 tipo B (slave) per PC
5 Ethernet

6 Alimentazione 12 V CC, 1,25 A

3.4. Tastiera

Tasto Descrizione

Accensione e spegnimento del visualizzatore

  

  
Funzioni dipendenti dal contesto

Accensione e spegnimento della memorizzazione automatica acceso  
il numero in fondo al nome del file è aumentato automaticamente con 
ogni nuova serie di prove, il simbolo del dischetto è visualizzato
Visualizzazione del valore medio e ultima prova singola a grandi cifre 
acceso: il simbolo del valore medio è visualizzato vicino al valore della 
misura

Definisce il nome di file alfanumerico della serie di misure

Apre il menu

Naviga attraverso il menu

Conferma la selezione

Chiude le finestre di dialogo

 Aumenta / diminuisce un numero

Accesso alla funzione di aiuto

Accende e spegne la retroilluminazione
acceso: regola la retroilluminazione (5 livelli)
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3.5. Struttura di menu

Main Menu
Measurement View Memory Config Help

Direction F1

Material F2

Scale F3

n... F4

Limits...

Close F5

Remove F6

Comment...

Print series 

Bar graph

Basic mode

Signal graph

Conversion 
function

Display mean 
[x-bar]

Set bar graph 
range...

Multiple series 
bar graph

Scale bar width

Save series 
[Disk]

Set series file 
name...  #

Set save 
folder...

Explorer...

Properties...

Language...

User interface...

Display...

System 
settings

User profiles

Signal 
compression...

Customer
conversions

Calibrate 
probe...

About 
EQUOTIP3...

Show help 
index...  ?

Show help 
content...  ?

Show system 
info...

4. Primi passi

4.1. Installazione dello strumento
Un Equotip 3 funzionale comprende le seguenti componenti:

•	 visualizzatore Equotip 3 per elaborare, visualizzare e memorizzare le misure
•	 sostegno Equotip 3 per fissare la parte posteriore del visualizzatore (o, in alternativa,  
	 utilizzare l’astuccio protettivo da trasporto con tracolla per una migliore portabilità)
•	 percussore Equotip collegato al visualizzatore tramite l’apposito cavo
•	 blocco per la prova di durezza Equotip per effettuare la verifica delle prestazioni

4.2. Accensione e spegnimento
Per accendere il visualizzatore Equotip 3 premere semplicemente  per circa due secondi. 
Lo strumento avvierà una sequenza di innesco, visualizzerà «Starting up...» (Avvio in corso...), 
«Loading configuration...» (Caricamento configurazione...) e lo schermo di misura. Lo schermo 
di misura visualizza l’ultima prova prima dello spegnimento.

4.3. Disattivazione automatica, standby e spegnimento
Conformemente alle impostazioni di gestione delle corrente, lo strumento si disattiva automa-
ticamente, si mette in standby o si spegne dopo un determinato lasso di tempo di inattività.

i
Nota: Se lo strumento è acceso ma lo schermo non risponde premendo un ta-
sto qualsiasi, è possibile effettuare un ripristino premendo il tasto di accensione 
e spegnimento per circa venti secondi.

4.4. Caricamento della batteria
Una batteria carica è sufficiente per almeno 8 ore di funzionamento. Il tempo di funzionamento 
può essere ampliato riducendo la luminosità della retroilluminazione o spegnendola. Se la bat-
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teria si scarica, l’indicatore sullo schermo inizia a lampeggiare fino a quando il visualizzatore 
eventualmente si spegne. Per ricaricare la batteria, utilizzare l’adattatore CA Equotip 3. Lo stato 
di carica della batteria è indicato con il LED verde accanto al tasto di accensione e spegnimento:

LED sempre acceso Batteria in fase di caricamento

Lampeggiante
- LED quasi sempre acceso
- LED quasi sempre spento

Visualizzatore in modalità standby
- Batteria in fase di caricamento
- Batteria non in fase di caricamento

LED sempre spento Batteria ricaricabile completamente carica o non inserita

Per un caricamento completo della batteria sono necessarie circa otto ore.

Pericolo: Utilizzare esclusivamente l’adattatore CA Equotip 3 (12 V, 1,25 A) per 
caricare il visualizzatore Equotip 3.

i
Nota: Solo la batteria Equotip 3 agli ioni di litio può essere caricata all’interno 
del visualizzatore Equotip 3.

i
Nota: La batteria agli ioni di litio integrata consente 500 cicli completi di carica 
e scarica. Se il tempo di funzionamento della batteria si riduce sensibilmente 
è necessario ordinare una nuova batteria. La batteria è giunta al termine della 
sua durata di vita se il LED non si spegne pur avendo caricato la batteria per 
diversi giorni.

4.5. Verifica delle prestazioni e verifica quotidiana

1.	 Verificare se il blocco per la prova di durezza Equotip è posizionato su una base solida in 
modo che non possa essere spostato e sia esente da vibrazioni. Utilizzare un blocco di 
prova con una durezza vicina a quella del pezzo da provare. Proceq propone blocchi di 
prova con quattro livelli di durezza.

2.	 Staccare la pellicola adesiva di protezione e conservarla per un utilizzo ulteriore. Verificare 
che la superficie da provare sia pulita, asciutta e liscia. Se necessario utilizzare acetone, 
isopropanolo o simili (non acqua!) per rimuovere i residui di adesivo o di sporcizia.

3.	 Accensione: per accendere il visualizzatore Equotip 3 premere  per circa due secondi.

4.	 Schermo: selezionare «Bar graph» (Grafico a barre) o «Basic mode» (Modalità di base) dal 
menu «View» (Vista), (vedi il capitolo 5.1. «Viste»).

5.	 Impostazioni : selezionare la compensazione automatica della direzione direzione d’urto 
[«a Automatic»(a automatica)] premendo F1 (vedi capitolo 6.1. «Impostazioni»). Se non è 
possibile selezionare «a», definire la direzione d’urto (    ). Selezionare la scala di 
durezza HL adatta per il percussore (HLD per il percussore D) premendo F3. Selezionare 
il numero di impatti n per le serie di misure premendo F4.

6.	 Effettuare 10 impatti, meglio se distribuiti uniformemente attraverso il diametro del blocco 
di prova (vedi capitolo 2.5. «Procedura di prova»).

7.	 Il punto medio di durezza definito del blocco è inciso sulla superficie. La media calcolata 
dovrebbe coincidere con il range di tolleranza (se così non fosse, riferirsi ai capitoli 4. 
«Primi passi» e 12. «Risoluzione dei problemi»).

Congratulazioni! Il vostro nuovo Equotip 3 è interamente funzionante e potete ora continuare 
con le vostre misure.



© 2013 by Proceq SA  	        14

i
Nota: Primo utilizzo: seguire le indicazioni contenute nel capitolo 'Teoria della 
prova di durezza con rimbalzo Leeb» o seguire una dimostrazione da parte di un 
rivenditore qualificato Proceq.

i
Nota: Verificare che la superficie sia pulita, liscia e asciutta prima di incollare  
nuovamente la pellicola adesiva di protezione sul blocco di prova.

i
Nota: La verifica delle prestazioni deve essere sempre effettuata prima di ogni 
utilizzo dello strumento al fine di verificare le funzioni meccaniche ed elettro-
niche del percussore e del visualizzatore. Tale requisito è altresì incluso negli 
standard DIN e ASTM di durezza Leeb.

5. Impostazione delle visualizzazioni e dello schermo
Il visualizzatore Equotip 3 offre molte opzioni di visualizzazione dei menu e delle misure.

5.1. Visualizzazioni
Accedere al submenu «View» (Vista) per definire il contenuto visualizzato sullo schermo:
•	 Bar graph (Grafico a barre): visualizza le misure come un grafico a barre. Questa vista è  
	 utile quando si misura il profilo di durezza di un pezzo
 -	 Multiple series bar graph (Grafico a barre multiserie): visualizzazione di più serie di misure.
 -	 Set bar graph range (Definisci campo grafico a barre): per visualizzare solo i principali campi 
	 di durezza, il campo da visualizzare può essere definito.
•	 Scale bar width (Larghezza della barra di scala): controlla la larghezza delle barre che  
	 rappresentano le prove.
•	 Basic mode (Modalità di base): visualizzazione dell’ultima prova/con il valore medio in cifre  
	 grandi. Questa vista è pratica quando si visualizza lo schermo da lontano o quando lo  
	 strumento è utilizzato con un sottofondo scuro come ad esempio il pavimento di uno  
	 stabilimento.
•	 Signal graph (Segnale grafico): l’attuale segnale di misura del percussore è visualizzato.  
	 Questa vista è comoda per dimostrare il principio di misura durante sedute di formazione  
	 o per una valutazione avanzata del segnale.
•	 Conversion function (Funzione di conversione): le misure sono visualizzate come punti di  
	 dati su un grafico nella funzione di conversione attiva. Questa visualizzazione consente di  
	 determinare il range delle prove nell'unità di durezza convertita nel range di dati nell’unità  
	 HL originale.

i
Nota: Il numero in grandi cifre sullo schermo può indicare anche il valore medio 
o l’ultima prova della serie di misure.

Usare  per passare da una modalità all’altra.

5.2. Retroilluminazione
La retroilluminazione può essere regolata a un livello predefinito semplicemente premendo  
più volte .

i
Nota: Navigare verso «Config» – «Display» (Schermo) per regolare il contrasto 
e la retroilluminazione.
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5.3. Suono
Il visualizzatore Equotip 3 può essere configurato [«Config» – «System settings» (Impostazioni 
sistema) – «Sound...» (Suono...)] per emettere allarmi sonori in presenza di eventi predefiniti. 
Per esempio, quando un segnale non può essere valutato o si superano i limiti, l’allarme sonoro 
segnala che la misura deve essere ripetuta oppure che il pezzo deve essere scartato. Il comple-
tamento della serie di misure può pure essere confermato con un suono di convalida. Questa 
funzione è utile in particolare quando si effettuano serie rapide di prove.

5.4. Aiuto sullo schermo
È possibile accedere alla funzione di 'Help' sullo schermo dell’Equotip 3 premendo  oppu-
re tramite il submenu «Help» (Aiuto).

5.5. Lingua di lavoro
La lingua desiderata può essere selezionata in «Config» – «Language» (Lingua).

6. Impostazioni
All’avvio, Equotip 3 si trova nello stesso stato prima dello spegnimento. Per adattare le  
impostazioni, premere «context sensitive function» (funzione dipendente dal contesto) o  
«open menu» (apri menu).

i

Nota: Se l’opzione di memorizzazione automatica è attiva, tutti i dati sono me-
morizzati automaticamente nel valore HL originale con informazioni supplemen-
tari quali direzione d’urto, tempo e numero di serie dello strumento utilizzato. 
Quando si trasferiscono dati al PC tramite il software Equolink 3, i dati possono 
essere convertiti in un’altra scala senza accumulare errori di conversione dato 
che il valore HL originale è utilizzato per tutte le conversioni.

6.1. Compensazione della direzione d’urto non verticale

Il fatto che la direzione d’urto devii dalla verticale può essere compensato automaticamente 
oppure in modo selettivo. Procedere come segue per adattare l’impostazione:
•	 Premere F1.
•	 Selezionare la direzione d’urto (    ) o selezionare «a Automatic» (a automatica) per  
	 la compensazione automatica.
•	 Confermare la selezione premendo . Le prove effettuate prima della nuova imposta- 
	 zione sono applicate in quanto non interessate dal cambiamento.
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i
Nota: I percussori Equotip 2 possono essere collegati al visualizzatore Equotip 
3 mediante un cavo speciale disponibile presso il rivenditore Proceq di zona. 
Ricordiamo che la funzione di compensazione automatica è disponibile solo 
per i percussori Equotip 3 tranne DL. Per le versioni precedenti e DL, utilizzare 
le opzioni     .

6.2. Gruppi di materiale

Procedere come segue per cambiare gruppo di materiale:

•	 Premere F2 per selezionare il gruppo di materiale. 

•	 Utilizzare i tasti di navigazione per selezionare un gruppo di materiale. 

•	 Confermare la selezione premendo . Se sono visualizzate sullo schermo, le prove  
	 saranno ora convertite tramite la funzione di conversione per il nuovo gruppo di materiale  
	 selezionato.

i

Nota: Per misurare nella scala originale Leeb HL, non deve essere selezionato 
nessun gruppo di materiale se non si applica una conversione. Per contro, le 
conversioni nelle altre scale di durezza sono corrette solo con il gruppo di ma-
teriale adeguato. La banca dati in linea e l’aiuto dell’Equotip 3 possono essere 
molto utili per attribuire il materiale a uno dei nove gruppi. La disponibilità di 
conversioni per il materiale specifico deve essere qualificata prima dell’uso su 
campioni calibrati. Contattare Proceq per maggiori informazioni.

i
Nota: Per una scala di durezza data, la finestra a scomparsa elenca solo i grup-
pi di materiale per i quali è disponibile una conversione.
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19-37

Campi di applicaione D/DC DL S E G C 

Acciaio e 
acciaio fuso
 
 
 
 
 
 

HV 81-955 80-950 101-964 84-1211  81-1012 

HB 81-654 81-646 101-640 83-686 90-646 81-694 

HRB 38-100 37-100   48-100  

HRC 20-68 21-68 22-70 20-72  20-70 

HRA   61-88 61-88   

HS 30-99 31-97 28-104 29-103  30-102 

σ1 275-2194 275-2297 340-2194 283-2195 305-2194 275-2194 

σ2 616-1480 614-1485 615-1480 616-1479  615-1479 

σ3 449-847 449-849 450-846 448-849  450-846 

Acciaio da attrezzi per
lavorazione a freddo

HV 80-900 80-905 104-924 82-1009  98-942 

HRC 21-67 21-67 22-68 23-70  20-67 

Acciaio inossidabile 
 

HV 85-802  119-934 88-668   

HB 85-655  105-656 87-661   

HRB 46-102  70-104 49-102   

HRC 20-62  21-64 20-64   

Ghisa, grafite 
lamellare GG
  
 

HB 90-664    92-326  

HV 90-698      

HRC 21-59      

Ghisa, grafite 
nodulare GG
   
 

HB 95-686    127-364  

HV 96-724      

HRC 21-60      

Leghe di alluminio fuso HB 19-164 20-187 20-184 23-176 19-168 21-167 

HV 22-193 21-191 22-196 22-198   

HRC 24-85 24-85   24-86 23-85 

Leghe rame/ 
zinco (ottone)
 

HB 40-173      

HRB 14-95      

Leghe CuAI/ 
CuSn (bronzo)

 

HB 60-290      

Leghe in
rame lavorato,
basso legato

HB 45-315      

Vickers: HV                                               Shore: HS 

Brinell: HB                                                 Tensile Strength Rm N/mm
2
: σ1, σ2, σ3 

Rockwell: HRB, HRC, HRA 


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6.3. Scale di durezza 
 

 
Procedere come segue per cambiare la scala di durezza mediante la funzione di conversio-
ne da HL a un’altra scala:

•	 Premere F3 per selezionare la scala di durezza. 
•	 Utilizzare i tasti di navigazione per selezionare una scala di durezza. 

•	 Confermare la selezione premendo  Se sono visualizzate sullo schermo, le prove 
saranno ora convertite nella nuova scala di durezza selezionata.

i
Nota: Per un gruppo di materiale dato, la finestra a scomparsa elenca solo le 
scale di durezza per le quali è disponibile una conversione.

i
Nota: Le misure di determinati acciai possono essere convertite in resistenza 
alla trazione conformemente a DIN EN ISO 18265.

i
Nota: Lo standard di conversione utilizzato per la conversione nella durezza 
Shore HS può essere modificato. Navigare verso «Config» – «Conversion 
standard» (Standard conversione) per scegliere fra la conversione default 
conformemente ad ASTM E448 o la conversione giapponese conforme-
mente a JIS B7731.
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6.4. Numero di impatti per serie di misure

 
 
Per concludere una serie di misure, è possibile chiudere la serie tramite le funzione 
«Close» (Chiudi). In alternativa se si inserisce ad esempio n = 5 impatti, la serie si conclude 
automaticamente quando sono stati memorizzati cinque valori. Procedere come segue 
per definire un numero fisso di impatti:

•	 Premere F4. 

•	 Utilizzare i tasti di navigazione per selezionare il numero desiderato di impatti. 

•	 Confermare la selezione premendo .

i
Nota: Le misure «peggiori» possono essere cancellate dalla serie di prova 
mediante i tasti di navigazione e premendo in seguito «Remove » (Elimina).
Verificare se le prove sono state cancellate conformemente alle principali 
linee guida sulla qualità oppure limitare la funzione utilizzando dei profili 
utente.

i
Nota: In seguito alla chiusura della serie di prova, è possibile decidere 
se aggiungere altre prove oppure se rifare le prove «peggiori» premendo 
semplicemente «More» (aggiungi). La funzione «New» (Nuovo) cancella lo 
schermo per iniziare una nuova serie.
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6.5. Nome del file delle serie di misure

Procedere come segue per definire il nome alfanumerico della serie di misure:

•	 Premere .
•	 Utilizzare i tasti di navigazione per inserire il nome del file. 

•	 Confermare la selezione premendo . Il nome del file può essere utilizzato come 
riferimento per il lotto / pezzo provato. Il nome del file identifica la serie di prove dopo aver 
scaricato i dati su un PC mediante Equolink 3 o il pacchetto di automazione Equotip 3.

i
Nota: Verificare che il simbolo del dischetto sia visualizzato se si desidera  
memorizzare automaticamente i dati della serie. Se la funzione è spenta, i dati 
misurati sono persi quando si chiude la serie.

i
Nota: È possibile usare le modalità di immissione stile tastiera o stile SMS. 
La configurazione può essere modificata in «Config» – «User interface»  
(Interfaccia utente). Una tastiera USB, un mouse USB o uno scanner USB 
può essere collegato alle porte di collegamento (presa USB tipo A).

i
Nota: Se una serie di misure è stata chiusa e la serie memorizzata, l’ultimo 
carattere alfanumerico del nome del file è incrementato automaticamen-
te. Un nome di file differente può essere definito manualmente premendo 

.
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6.6. Limiti

Procedere come segue per definire i limiti di durezza inferiore e superiore per il pezzo provato: 

•	 Premere  per aprire il submenu «Measurement» (Misure) e selezionare «Limits...»  
	 (Limiti). 

•	 Utilizzare i tasti di navigazione e  per attivare il limite superiore e/o inferiore. 
 
	 I limiti possono essere modificati premendo  . 

•	 Confermare la selezione premendo . Il campo delle prove «migliori» è ora illuminato  
	 in grigio e i valori fuori limite sono evidenziati con accanto un «+» o un «-».
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7. Impostazioni avanzate
Nel presente capitolo sono descritte le funzioni avanzate più utilizzate del visualizzatore  
Equotip 3. Istruzioni per l’uso più dettagliate del visualizzatore Equotip 3 possono essere  
scaricate dal sito www.proceq.com.

7.1. Curve di conversione personalizzate

7.1.1. Minimizzazione degli errori di conversione
Se il gruppo di materiale è stato selezionato correttamente, gli errori di conversione non  
dovrebbero superare ±2 HR per le scale Rockwell e ±10 per cento per HB e HV. Nella mag-
gior parte dei casi, l’errore di conversione è nettamente inferiore. Se è richiesta la massima 
precisione oppure se la lega oggetto della prova non è inserita in una delle conversioni inte-
grate, Equotip 3 fornisce una serie di metodi per definire le conversioni specifiche al materiale.  
Queste curve di conversione personalizzate possono essere definite tramite «Config» –  
«Customer Conversions» (Conversioni personalizzate), e utilizzate tramite la finestra di dialogo 
delle «scale di durezza» (vedi capitolo 6.3. «Scale di durezza»).

7.1.2. Metodi per definire le conversioni personalizzate
Equotip 3 fornisce tre metodi per personalizzare le conversioni (p.es. HLD → HRC):
•	 metodo un punto: la durezza Leeb HLD e la durezza nella scala desiderata HRC sono  
	 determinate per un pezzo di riferimento. Una funzione standard di conversione HLD-HRC  
	 è in seguito adattata a un offset verticale fino a quando i dati di riferimento misurati si  
	 situano sulla curva grafica.
•	 metodo due punti: due campioni di riferimento sono provati, uno il più duro possibile e  
	 l’altro il più morbido possibile al fine di trovare due coppie di dati HLD / HRC. Una funzione  
	 standard di conversione HLD-HRC è in seguito adattata aggiungendo una linea retta fino a  
	 quando le coppie di dati di riferimento misurate si situano sulla curva grafica.
•	 conversione polinomiale: se una conversione personalizzata deve essere applicata in un  
	 ampio campo di durezza, diversi campioni di riferimento devono essere provati al fine di  
	 trovare una solida base di interpolazione. Nel visualizzatore Equotip 3 è possibile program- 
	 mare fino a polinomiali di quinto grado definendo un coefficiente polinomiale Ai in  
	 HRC(HLD) = A0 + A1·HLD + A2·HLD2 + A3·HLD3 + A4·HLD4 + A5·HLD5.

7.1.3. Esempio di curva personalizzata
•	 Le coppie di dati (640 HLD / 41,5 HRC e 770 HLD / 54,5 HRC) sono state misurate su due  
	 campioni di riferimento in «acciaio speciale».
•	 Per misurare «acciai speciali» con una conversione HLD-HRC personalizzata, la curva di  
	 conversione originale HLD-HRC per «1 Acciaio e acciaio fuso» è inclinata con una coppia  
	 di dati di punti. In questo esempio, la conversione speciale è definita valida per il campo  
	 da 41 a 55 HRC.
•	 Non appena creata, la curva può essere selezionata dal gruppo di materiale «Customer  
	 defined» (Personalizzato) – «Special steel» (Acciaio speciale) con la scala di durezza  
	 «HRC Rockwell C».
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7.1.4. Campioni di riferimento per la misura
•	 Le superfici dei campioni devono essere preparate con molta attenzione. Se possibile,  
	 i campioni devono avere una massa che non renda necessario un loro accoppiamento  
	 a un supporto.
•	 Il funzionamento dell’Equotip 3 deve essere verificato con il blocco di prova Leeb prima  
	 di ogni serie di misure.
•	 Il funzionamento del durometro statico (HV, HB, HRC ecc.) deve essere vverificato con i  
	 blocchi di prova prova corrispondenti alla scala e al campo di misura.
•	 Per ottenere una coppia di valori comparativi deve essere calcolato il valore medio di  
	 almeno 10 a 15 valori di misura HL e di 3 valori dalla prova statica. Tali valori saranno  
	 ottenuti eseguendo le prove nella stessa zona del blocco di prova.
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7.2. Stampa dei dati e uscite digitali con porte di collegamento
Equotip 3 è equipaggiato per default con porte USB, ethernet ed RS 232:
•	 USB tipo A: presa per tastiera, mouse, lettore di codice a barre, stampante.
•	 USB tipo B: riferirsi alle istruzioni per l’uso separate «Software Equolink 3» 
	 incluse nel CD Equotip.
•	 Ethernet: configurazione possibile tramite «Config» – «System settings»  
	 (Impostazioni sistema) – «IP settings...» (Impostazioni IP...). Inserire l’indirizzo IP  
	 dello strumento o ricorrere all’opzione DHCP.
•	 RS 232 (seriale): l’interfaccia RS 232 può essere utilizzata per la stampa,  
	 ma considerata la velocità ridotta non è adatta per l’aggiornamento dello strumento. 

•	 Installazione stampante: le stampanti possono essere collegate con USB o interfaccia  
	 RS 232. La configurazione è possibile tramite «Config» – «System settings» (Impostazioni  
	 sistema) – «Printer...» (Stampante...). Diverse stampanti possono essere selezionate da un  
	 elenco. Se è stato attivato «Autoprint at end of series» (Stampa automatica a fine serie),  
	 il visualizzatore stamperà automaticamente un protocollo ogni qualvolta una serie di  
	 misure è conclusa. In alternativa è possibile stampare un protocollo della serie attuale  
	 tramite «Measurement» (Misura) – «Print series» (Stampa serie) – «Long protocol»  
	 (Protocollo lungo) o «Short protocol» (Protocollo corto).

i
Nota:

La comunicazione via collegamento ethernet è più rapida rispetto a USB.

i
Nota:

Il pacchetto di automazione Equotip 3 aggiunge una presa di uscita 
pentapolare DIN. Riferirsi alle istruzioni per l’uso separate o contattare il 
rivenditore Proceq di zona per maggiori informazioni.
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7.3. Profili degli utenti protetti da parole chiave

7.3.1. Minimizzazione degli errori di funzionamento e aumento dell’efficienza
Il superutente può definire i profili in «Config» – «User profiles» (Profili utenti). I profili utente 
possono essere configurati per i seguenti scopi:
•	 impostazioni dello strumento specifiche al campione: i requisiti delle prove di durezza  
	 possono variare a seconda del pezzo. Per esempio, la durezza di campioni morbidi e  
	 duri può implicare l’utilizzo del percussore G con conversione a HRB e il percussore E con  
	 conversione a HRC. In questo caso, due profili utente «Acciaio morbido» e «Acciaio duro»  
	 possono essere definiti per la prova con impostazioni e restrizioni adattate al rispettivo  
	 pezzo. Ciò consente un rapido cambio di impostazioni con un rischio minimo di errore.
•	 impostazioni dello strumento specifiche all’utente: due utenti che effettuano prove in  
	 ambienti differenti possono configurare le loro preferenze di visualizzazione dei dati sullo  
	 schermo (grafico a barre, modalità di base ecc.) e le impostazioni dello schermo  
	 (retroilluminazione, contrasto).
•	 restrizioni di accesso: protezione con password per affidare la prova solo a una determi- 
	 nata persona e poter tracciare i risultati. Anche l’accesso ai dati confidenziali può essere  
	 limitato.

7.3.2. Esempio di profilo utente

•	 L’utente «Dietmar Leeb» dispone di diritti d’accesso limitati per le misure.
•	 Da un lato può regolare le impostazioni della direzione d’urto durante la prova. Dietmar  
	 Leeb può quindi effettuare il numero di impatti per serie di misure che ritiene opportuno  
	 per una valutazione sonora.
•	 D’altro lato non può invece modificare le impostazioni per materiale e scala in quanto il  
	 compito di Dietmar Leeb è di provare la durezza di parti in alluminio nella scala Brinell.  
	 Per questa parte è definito anche il passo/errore.
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8. Valutazione dei dati

8.1. Statistiche

Le statistiche delle serie di misure fino a un massimo di 9999 impatti sono calcolate automa-
ticamente:

•	 numero di impatti n = 10, limite inferiore 37,0 HRC, limite superiore 42,0 HRC.
•	 Il grafico a barre fornisce una comoda vista d’insieme e conferma che tutte le dieci prove  
	 effettuate sono entro i limiti.
•	 Le statistiche delle serie (media x, deviazione standard s, max./min., campo di valore R)  
	 sono visualizzate nella parte superiore dello schermo.
•	 Le singole prove sono visualizzate nella parte inferiore dello schermo.

i
Nota: La serie di misure è completata automaticamente quando si superano 
le n = 9999 prove. La misura successiva corrispondente al primo valore di una 
nuova serie di misure.

8.2. Software Equolink 3
Il software Equolink 3 per PC mette a disposizione diverse funzioni supplementari per Equotip. 
Sul CD Equotip sono disponibili istruzioni per l’uso separate «Software Equolink 3».
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9. Specifiche tecniche

9.1. Dati generali

Dimensioni			   170 x 200 x 45 mm (6,7 x 7,9 x 1,8 pollici)
Peso				    780 g (27,5 once) più blocco batterie 120 g (4,2 once)
Alloggiamento			   plastica ABS resistente agli urti
Schermo				    LCD QVGA di grandi dimensioni con contrasto e  
				    retroilluminazione regolabili
Memoria integrata			   flash 32 MB (non volatile), RAM 64 MB (volatile)
Memorizzazione interna dei dati	 da 100 000 a 1 000 000 di valori  
				    (a seconda del tipo di dati)
Interfaccia			   ethernet, USB 1.1, RS 232
Tipo di batterie			   3 batterie «C» standard, ricaricabili agli ioni di litio
Tensione nominale della batteria	 3,7 V
Capacità nominale della batteria	 4,3 Ah
Tensione max. della batteria carica	 4,2 V
Tensione di entrata		   	 da 9 a 16 V CC
Corrente max. di entrata a 12 V	 1 A
Corrente max. di entrata a 9,4 V	 1,3 A
Periodo di funzionamento della batteria	 di regola 10 ore
Temperatura d’esercizio		  da 0 a 50 °C (da 32 a 122 °F)
Umidità				    non condensante, max. 90 %

9.2. Percussori Equotip 3
Campo di misura		  1-999 HL
Precisione di misura	 ± 4 HL (0,5 % a 800 HL)
Risoluzione		  1 HL; 1 HV; 1 HB; 0,1 HRA; 0,1 HRB, 0,1 HRC; 0,1 HS; 1 MPa	
			    (N/mm2)
Direzione d’urto		  compensazione automatica (sonda DL esclusa)
Energia d’impatto	 	 • 11,5 Nmm per le sonde D, DC, E, S
	 	 	 • 11,1 Nmm per la sonda DL
	 	 	 • 3,0 Nmm per la sonda C
	 	 	 • 90,0 Nmm per la sonda G
Massa del corpo di battuta	 • 5,45 g (0,2 once) per le sonde D, DC, E, S
	 	 	 • 7,25 g (0,26 once) per la sonda DL
	 	 	 • 3,1 g (0,11 once) per la sonda C
	 	 	 • 20,0 g (0,71 once) per la sonda G
Penetratore sferico	 	 • carburo di tungsteno, Ø 3,0 mm (0,12 pollici) per le sonde  
			      C, D, DC
	 	 	 • carburo di tungsteno, Ø 2,78 mm (0,11 pollici) per la sonda DL
	 	 	 • carburo di tungsteno, Ø 5,0 mm (0,2 pollici) per la sonda G
	 	 	 • ceramica, Ø 3,0 mm (0,12 pollici) per la sonda S
	 	 	 • diamante policristallino, Ø 3,0 mm (0,12 pollici) per la sonda E
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9.3. Standard e linee guida applicate
•	 DIN 50156 (2007)
•	 Linee guida DGZfP MC 1 (2008)
•	 Linee guida VDI / VDE 2616 foglio 1 (2002)
•	 ISO 18625 (2003)
•	 ASTM A956 (2006)
•	 Nordtest Technical Report Series 424, Reports 99.12/13 (1999)
•	 ASME Final Report CRTD-91
•	 GB/T 17394 (1998)
•	 JB/T 9378 (2001)
•	 JJG 747 (1999)
•	 CNAL T0299 (2008)
•	 JIS B7731 (2000)

10. Codici dei pezzi di ricambio e accessori

Art. n. Unità Equotip 3

353 10 100 Durometro Equotip 3, tipo D, comprendente: visualizzatore con sostegno, 
adattatore CA, percussore D [con cavo quadripolare 1,5 m, corpo di battuta 
D, testina d’urto piccola (D6a) e grande (D6), spazzola per pulizia], blocco 
di prova D/DC (~ 775 HLD/~ 630 HV/~ 56 HRC), pasta di accoppiamento, 
cavo USB, CD Equotip con software Equolink 3 e documentazione sul 
prodotto, istruzioni per l’uso, guida rapida, certificati di prodotto, borsa da 
trasporto

353 10 300 Durometro Equotip 3, tipo G, comprendente: visualizzatore con sostegno, 
adattatore CA, percussore G [con cavo quadripolare 1,5 m, corpo di battuta 
G, testina d’urto piccola (G6a) e grande (G6), spazzola per pulizia], blocco 
di prova G (~ 570 HLG/~ 340 HB), cavo USB, CD Equotip con software 
Equolink 3 e documentazione sul prodotto, istruzioni per l’uso, guida rapida, 
certificati di prodotto, borsa da trasporto

353 10 050 Durometro Equotip 3, unità di base, comprendente: visualizzatore con 
sostegno, adattatore CA, cavo USB, CD Equotip con software Equolink 3 e 
documentazione sul prodotto, istruzioni per l’uso, guida rapida, certificati di 
prodotto, borsa da trasporto

353 00 091 Pacchetto di automazione Equotip 3, comprendente: cavo quadripolare  
1,5 m con raccordo di derivazione per automazione, CD Equotip, librerie  
per automazione, software Equolink 3 e documentazione sul prodotto, 
istruzioni per l’uso

353 13 000 Durometro Equotip SVP 40 comprendente: strumento con sostegno, 
caricatore CA, sonda Equotip SVP 40 (con cavo di trasmissione di 10 m, 
cassetta di collegamento Equotip SVP 40 cassetta con alimentazione, 
cavo quadripolare 1,5 m, spazzola per pulizia), blocco di prova SVP 40 
(~ 850 HLSVP/~ 630 HV/~ 56 HRC), cavo USB, CD Equotip con software 
Equolink 3 e documentazione sul prodotto, istruzioni per l’uso, guida rapida, 
certificati di prodotto, borsa da trasporto
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Art. n. Garanzie
353 88 031 Estensione di garanzia di 1 anno sul durometro Equotip 3, unità di base
353 88 032 Estensione di garanzia di 2 anni sul durometro Equotip 3, unità di base
353 88 033 Estensione di garanzia di 3 anni sul durometro Equotip 3, unità di base
353 88 001 Estensione di garanzia di 1 anno sul durometro Equotip 3, tipo D
353 88 002 Estensione di garanzia di 2 anni sul durometro Equotip 3, tipo D
353 88 003 Estensione di garanzia di 3 anni sul durometro Equotip 3, tipo D
353 88 021 Estensione di garanzia di 1 anno sul durometro Equotip 3, tipo G
353 88 022 Estensione di garanzia di 2 anni sul durometro Equotip 3, tipo G
353 88 023 Estensione di garanzia di 3 anni sul durometro Equotip 3, tipo G
350 88 031 Estensione di garanzia di 1 anno sulla sonda Equotip SVP 40
350 88 032 Estensione di garanzia di 2 anni sulla sonda Equotip SVP 40
350 88 033 Estensione di garanzia di 3 anni sulla sonda Equotip SVP 40

Art. n. Percussori Equotip 3
353 00 100 Percussore Equotip 3 D
353 00 110 Percussore Equotip 3 DC
353 00 120 Percussore Equotip 3 DL
353 00 200 Percussore Equotip 3 S
353 00 300 Percussore Equotip 3 G
353 00 400 Percussore Equotip 3 E
353 00 500 Percussore Equotip 3 C
350 13 001 Sonda Equotip SVP 40
353 00 101 Percussore di base Equotip 3 D
353 00 111 Percussore di base Equotip 3 DC
353 00 121 Percussore di base Equotip 3 DL
353 00 201 Percussore di base Equotip 3 S
353 00 301 Percussore di base Equotip 3 G
353 00 401 Percussore di base Equotip 3 E
353 00 501 Percussore di base Equotip 3 C

Art. n. Corpi di battuta Equotip 3
350 01 004 Corpo di battuta Equotip D/DC
350 71 311 Corpo di battuta Equotip DL
350 71 413 Corpo di battuta Equotip S
350 08 002 Corpo di battuta Equotip G
350 07 002 Corpo di battuta Equotip E
350 05 003 Corpo di battuta Equotip C
350 13 007 Corpo di battuta Equotip DD+35 (per Equotip SVP 40)

Art. n. Testine d’urto Equotip 3
350 01 009 Testina d’urto Equotip D6
350 01 010 Testina d’urto Equotip D6a
350 08 004 Testina d’urto Equotip G6
350 08 005 Testina d’urto Equotip G6a
350 71 314 Testina d’urto Equotip DL
350 13 014 Testina d’urto Equotip DD6a (per Equotip SVP 40)
353 03 000 Set di testine d’urto Equotip 3 (12 pezzi) adatte per D/DC/C/E/S
353 03 001 Testina d’urto Equotip 3 Z 10-15
353 03 002 Testina d’urto Equotip 3 Z 14,5-30
353 03 003 Testina d’urto Equotip 3 Z 25-50
353 03 004 Testina d’urto Equotip 3 HZ 11-13
353 03 005 Testina d’urto Equotip 3 HZ 12,5-17
353 03 006 Testina d’urto Equotip 3 HZ 16,5-30
353 03 007 Testina d’urto Equotip 3 K 10-15
353 03 008 Testina d’urto Equotip 3 K 14,5-30
353 03 009 Testina d’urto Equotip 3 HK 11-13
353 03 010 Testina d’urto Equotip 3 HK 12,5-17
353 03 011 Testina d’urto Equotip 3 HK 16,5-30
353 03 012 Testina d’urto Equotip 3 UN



Art. n. Blocchi di prova Equotip
357 11 100 Blocco di prova Equotip D/DC, calibrato da Proceq  

(< 500 HLD/< 225 HV/< 220 HB)

357 12 100 Blocco di prova Equotip D/DC, calibrato da Proceq  
(~ 600 HLD/~ 335 HV/~ 325 HB/~ 35 HRC)

357 13 100 Blocco di prova Equotip D/DC, calibrato da Proceq  
(~ 775 HLD/~ 630 HV/~ 56 HRC)

357 13 105 Blocco di prova Equotip D/DC, calibrato su un lato da Proceq  
(~ 775 HLD/~ 630 HV/~ 56 HRC)

357 11 120 Blocco di prova Equotip DL, calibrato da Proceq  
(< 710 HLDL/< 225 HV/< 220 HB)

357 12 120 Blocco di prova Equotip DL, calibrato da Proceq  
(~ 780 HLDL/~ 335 HV/~ 325 HB/~ 35 HRC)

357 13 120 Blocco di prova Equotip DL, calibrato da Proceq  
(~ 890 HLDL/~ 630 HV/~ 56 HRC)

357 11 500 Blocco di prova Equotip C, calibrato da Proceq  
(< 565 HLC/< 225 HV/< 220 HB)

357 12 500 Blocco di prova Equotip C, calibrato da Proceq  
(~ 665 HLC/~ 335 HV/~ 325 HB/~ 35 HRC)

357 13 500 Blocco di prova Equotip C, calibrato da Proceq  
(~ 835 HLC/~ 630 HV/~ 56 HRC)

357 13 200 Blocco di prova Equotip S, calibrato da Proceq  
(~ 815 HLS/~ 630 HV/~ 56 HRC)

357 14 200 Blocco di prova Equotip S, calibrato da Proceq  
(~ 875 HLS/~ 800 HV/~ 63 HRC)

357 13 400 Blocco di prova Equotip E, calibrato da Proceq  
(~ 740 HLE/~ 630 HV/~ 56 HRC)

357 14 400 Blocco di prova Equotip E, calibrato da Proceq  
(~ 810 HLE/~ 800 HV/~ 63 HRC)

357 31 300 Blocco di prova Equotip G, calibrato da Proceq (< 450 HLG/< 200 HB)

357 32 300 Blocco di prova Equotip G, calibrato da Proceq (~ 570 HLG/~ 340 HB)

353 13 040 Blocco di prova Equotip SV 40, calibrato da Proceq  
(~ 850 HLSVP/~ 630 HV/~ 56 HRC)

Art. n. Calibratura dei blocchi di prova
357 10 109 Calibratura supplementare del blocco di prova Equotip D/DC 

(calibratura supplementare con un percussore D/DC su un blocco di 
prova Equotip, certificato di calibratura incluso)

357 10 129 Calibratura supplementare del blocco di prova Equotip DL  
(calibratura supplementare con un percussore DL su un blocco di 
prova Equotip, certificato di calibratura incluso)

357 10 209 Calibratura supplementare del blocco di prova Equotip S  
(calibratura supplementare con un percussore S su un blocco di 
prova Equotip, certificato di calibratura incluso)

357 10 409 Calibratura supplementare del blocco di prova Equotip E  
(calibratura supplementare con un percussore E su un blocco di 
prova Equotip, certificato di calibratura incluso)

357 10 509 Calibratura supplementare del blocco di prova Equotip C  
(calibratura supplementare con un percussore C su un blocco di 
prova Equotip, certificato di calibratura incluso)
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357 30 309 Calibratura supplementare del blocco di prova Equotip G  
(calibratura supplementare con un percussore G su un blocco di 
prova Equotip, certificato di calibratura incluso)

357 90 909 Calibratura supplementare del blocco di prova Equotip, certificata da 
un istituto accreditato conformemente a DIN 50156-3 (Leeb)

357 90 919 Calibratura supplementare del blocco di prova Equotip, certificata da 
un istituto accreditato conformemente a ISO 6506-3 (Brinell)

357 90 929 Calibratura supplementare del blocco di prova Equotip, certificata da 
un istituto accreditato conformemente a ISO 6507-3 (Vickers)

357 90 939 Calibratura supplementare del blocco di prova Equotip, certificata da 
un istituto accreditato conformemente a ISO 6508-3 (Rockwell)

Art. n. Accessori
353 00 001 Visualizzatore Equotip 3

353 00 010 Struttura di sostegno Equotip 3

353 00 085 Adattatore CA Equotip 3

353 00 029 Batteria ricaricabile Equotip 3

353 99 011 Valigetta Equotip 3 con compartimenti per blocco di prova (tranne G) 
e accessori

353 00 070 Astuccio di protezione per il visualizzatore Equotip 3 (da utilizzare 
assieme a 380 00 079)

380 00 079 Collare regolabile, con imbottitura (da utilizzare assieme a 380 00 070)

353 00 037 Tracolla Equotip 3

353 00 080 Cavo per percussore Equotip 3, 1,5 m (quadripolare)

353 00 086 Prolunga per percussore Equotip 3, 5 m (quadripolare)

353 00 083 Cavo per percussore Equotip 2 / 3, 1,5 m (quadripolare / ventipolare)

353 00 084 Cavo per percussore Equotip 3 / 2, 1,5 m (quadripolare / tripolare)

353 00 089 Cavo per percussore Equotip 3 / 1, 1,5 m (quadripolare / bipolare)

350 01 039 Cavo di collegamento Equotip SVP 40 bipolare/ventipolare fra il 
visualizzatore Equotip 3 e l’alimentazione SVP

353 00 082 Cavo adattatore Equotip 3 RS 232 1,5 m per il collegamento a una 
stampante

351 90 018 Cavo USB, 1,8 m

350 01 015 Pasta di accoppiamento Equotip (bidone)

350 71 316 Manicotto in plexiglas per percussore Equotip DL

350 01 007 Penna di caricamento per percussore Equotip DC

350 01 008 Spazzola per pulizia Equotip D/DC/C/E/D+15/S/SVP40

350 08 006 Spazzola per pulizia Equotip G
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11. Manutenzione e assistenza tecnica
Proceq si impegna a fornire un servizio di assistenza completa per questo strumento. Gli ag-
giornamenti e altre informazioni utili sono disponibili sul sito www.proceq.com.

11.1. Controlli regolari dello strumento
La verifica delle prestazioni (vedi capitolo 4.5. «Verifica delle prestazioni») dello strumento do-
vrebbe essere effettuata almeno una volta al giorno o almeno dopo 1000 impatti. In caso di 
funzionamento saltuario effettuare la verifica prima dell’inizio e al termine delle serie di prove. 
In aggiunta, lo strumento dovrebbe essere calibrato ogni anno da un centro di assistenza au-
torizzato di Proceq.

i
Nota: Lo strumento funziona correttamente se il valore medio si trova nel  
campo obiettivo. Se il valore medio devia dal valore definito di oltre ±6 HL, vedi 
il capitolo 12. «Risoluzione dei problemi».

11.2. Pulizia
•	 Percussore:

a)	 Svitare la testina d’urto.
b)	 Togliere il corpo di battuta dal tubo guida.
c)	 Pulire il tubo guida con la spazzola per pulizia.
d)	 Riassemblare.

•	 Sfera del penetratore: pulire la sfera del corpo di battuta con acetone, isopropanolo o simili.
•	 Alloggiamento: pulire lo schermo e l’alloggiamento con uno straccio pulito e asciutto dopo  
	 l’uso. Pulire anche le prese di collegamento con una spazzola pulita e asciutta.

i
Nota: Non immergere in nessun caso lo strumento in acqua e non pulirlo con 
acqua corrente. Non utilizzare sostanze abrasive, solventi o lubrificanti per pu-
lire lo strumento.

i
Nota: Se il pavimento della fabbrica è sporco, polveroso e ruvido si raccoman-
da di utilizzare lo strumento con l’astuccio protettivo da trasporto Equotip 3.

11.3. Conservazione
Conservare Equotip 3 unicamente nell’imballaggio originale e in un locale asciutto senza 
polvere.

11.4. Ricalibratura della funzione di compensazione per la direzione  
	 d’urto non verticale
La funzione di compensazione si riferisce a parametri specifici a ogni percussore 
memorizzati sullo strumento. La validità della calibratura attuale può essere verificata 
tramite «Config» - «Calibrate probe» (Calibra sonda) e premendo in seguito «Test» (Prova). 
Per ogni direzione d’urto, la deviazione dalla curva deve essere inferiore a ±0,2.
I parametri possono variare con il tempo o in seguito a influssi esterni. La ricalibratura della 
compensazione automatica dei percussori Equotip 3 (tranne tipo DL) è raccomandata in 
particolare quando
•	 è stato pulito il percussore, o
•	 il percussore non è stato utilizzato da molto tempo, o
•	 è stato sostituito il corpo di battuta.
La ricalibratura è effettuata selezionando in sequenza «0° (giù)», «90° (oriz.)», «180° (su)» 
ed effettuando tre impatti per ogni direzione.
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11.5. Aggiornamento del firmware Equotip 3 e del sistema operativo
Collegare lo strumento al computer. Gli aggiornamenti sono effettuati utilizzando Equolink 3 
come segue:
•	 installare Equolink 3 sul PC dal registro «Equotip 3\Equolink 3 PC Software\»  
	 sul CD Equotip.
•	 selezionare il menu «Device» (Strumento) dalla barra dei menu e selezionare «PqUpgrade»  
	 nel submenu oppure cliccare sul simbolo nella barra degli strumenti.
•	 selezionare «Express» (Espresso) e confermare con «Next» (Avanti).
•	 selezionare il tipo di strumento e confermare con «Next» (Avanti).
•	 nella finestra «Choose Communication Type» (Scegli tipo di comunicazione), selezionare il  
	 tipo di comunicazione usato fra Equotip 3 e PC e cliccare in seguito su «Next» (Avanti).
•	 nella finestra «Device search result and selection» (Risultato della ricerca dello strumento e  
	 selezione) verificare se il numero di serie dello strumento nel campo a scomparsa  
	 corrisponde allo strumento da aggiornare e premere in seguito «Next» (Avanti).
•	 PqUpgrade cerca ora gli eventuali aggiornamenti disponibili nei server Proceq.
•	 seguire le istruzioni sullo schermo per terminare l’aggiornamento.

i
Nota: Prima di aggiornare il firmware, i dati misurati devono essere memorizzati 
sul PC.

i
Nota: L’aggiornamento «personalizzato» è raccomandato unicamente agli  
utenti esperti.
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12. Risoluzione dei problemi

12.1. Verifica delle misurazioni inesatte o delle prestazioni carenti
•	 Durante la verifica, se il valore medio devia di oltre ±6 HL dal punto definito:

1.	 Pulire il corpo di battuta prestando particolare attenzione alla sfera del penetratore 
sulla parte inferiore e all’arresto sulla parte superiore del corpo). Se necessario, 
sostituire il corpo di battuta o il blocco di prova se non vi è spazio sufficiente per 
prove supplementari.

2.	 Pulire il percussore.
3.	 Verificare il montaggio e l’usura della testina d’urto. Verificare la presenza di depositi. 

Pulire o sostituire se necessario.
4.	 Se lo strumento presenta sempre delle deviazioni eccessive: spedire lo strumento a 

un centro di assistenza autorizzato di Proceq per una ricalibratura o una revisione.
•	 Il gruppo di materiale, la scala di durezza scorretta o un’impostazione errata della direzione  
	 d’urto devono essere selezionati. Riferirsi al capitolo 6. «Impostazioni».
•	 La scala di durezza selezionata non si trova nel campo ammesso («noCnv»). Selezionare  
	 un’altra scala.
•	 I singoli valori hanno una dispersione ampia o sono costantemente troppo bassi:

1.	 la zona di prova non è preparata in modo sufficiente. Preparare con attenzione la zona 
di prova per l’impatto, vedi capitolo 2.2. «Preparazione del campione».

2.	 L’impatto è effettuato mentre lo strumento non è tenuto verticalmente sulla superficie. 
Ciò succede in particolare usando il percussore DL. Provare a utilizzare il manicotto in 
plexiglas per un migliore allineamento.

3.	 Il campione è supportato in modo insufficiente. Preparare il campione per l’impatto 
p.es. applicando la pasta di accoppiamento Equotip, vedi capitolo 2.6. «Prova di 
campioni leggeri».

i
Nota: Non ripassare i blocchi di prova o tentare di rinnovare i corpi di battuta. 
Tale operazione logora la precisione e potrebbe danneggiare la funzionalità di 
Equotip 3.

12.2. Nessuna lettura visualizzata
•	 Verificare il collegamento del percussore e l'integrità dello stesso.
•	 Verificare se nel percussore è inserito un corpo di battuta Equotip originale  
	 (con incisa la dicitura «equo») svitando la testina d’urto.
•	 Verificare la tenuta della testina d’urto sul filetto del percussore.
•	 Verificare se il corpo di battuta è armato e rilasciato quando si effettua la procedura di  
	 carica-rilascio. In caso negativo, il mandrino di bloccaggio del percussore potrebbe essere  
	 rotto. Sostituire il percussore con un percussore di base Equotip 3.

12.3. Schermo spento
•	 Se sullo schermo non appare nulla, attivare lo strumento premendo un tasto qualsiasi o  
	 effettuando un impatto.
•	 Se non succede nulla, lo strumento potrebbe essere troppo freddo oppure la batteria po 
	 trebbe essere scarica. Spostare lo strumento in un posto più caldo e/o caricare la batteria.

12.4. Batteria
•	 Se il visualizzatore non si accende, ricaricare la batteria tramite l’adattatore CA Equotip 3,  
	 vedi capitolo 4.4. «Caricamento della batteria».
•	 La batteria va sostituita con un’altra batteria agli ioni di litio Equotip 3 oppure con tre  
	 batterie di tipo «C» (alcaline, NiCd o NiMH). Le batterie agli ioni di litio possono essere riciclate.
•	 Ricalibratura dell’indicatore di durata

1.	 Verificare che le impostazioni in «Config» – «System settings» (Impostazioni sistema) 
– «Power manager...» (Gestione energia...) siano tutte definite su «never» (mai).
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2.	 Scaricare completamente la batteria, p.es. mantenendo acceso lo strumento fino a 
quando si spegne automaticamente.

3.	 Ricaricare completamente la batteria mentre lo strumento è in funzione.
4.	 Per verificare lo stato della batteria, controllare i timbri e la percentuale di durata 

di vita sotto «Help» (Aiuto) – «Show system info...» (Visualizza informazioni 
sistema...).

i

Nota: Non togliere o inserire la batteria agli ioni di litio quando lo strumento fun-
ziona con alimentazione esterna. Ciò potrebbe provocare un ripristino acciden-
tale dell’indicatore della durata di vita con una conseguente indicazione errata 
dello stato della batteria. Se il tempo di funzionamento della batteria si riduce 
sensibilmente, ordinare una nuova batteria. La batteria è giunta al termine della 
sua durata di vita se il LED non si spegne pur avendo caricato la batteria per 
diversi giorni.

Pericolo: Utilizzare esclusivamente l’adattatore CA Equotip 3 (12 V, 1,25 A) per 
caricare il visualizzatore Equotip 3.

12.5. Messaggi di errore
•	 «The application contains no version information...»  
	 (L’applicazione non contiene informazioni sulla versione...):

Cause possibili:
1.	 Errore fatale durante l’aggiornamento dello strumento, p.es. interruzione di corrente.
2.	 La memoria flash dello strumento è difettosa.
Contromisure:
1.	 Cancellare l’aggiornamento premendo «sì» quando è visualizzato il messaggio di 

errore. Effettuare nuovamente l’aggiornamento.
2.	 Se l’errore permane, contattare un centro di assistenza autorizzato Proceq.

•	 «Boot menu» (Menu boot):
1.	 Se file critici del visualizzatore Equotip 3 sono corrotti, il menu boot è utile per 

ripristinare il funzionamento dello strumento.
2.	 In questo caso, premere «Start Default Application» (Avvia applicazione default).

i
Nota: 
È possibile accedere al menu boot premendo contemporaneamente  e  
durante la sequenza di innesco nel caso in cui il visualizzatore non si inneschi 
più correttamente.

12.6. Rallentamento dello strumento
Lo strumento reagisce molto lentamente, i tasti devono p.es. essere premuti per diversi secon-
di affinché la pressione del tasto sia registrata oppure le misure sono visualizzate con diversi 
secondi di ritardo.
•	 Più dati sono scritti nella memoria flash (p.es. serie di misure, cicli di accensione e  
	 spegnimento dello strumento, aggiornamenti dello strumento) e più sovente si presenterà  
	 tale situazione.
•	 Il disco flash viene pulito automaticamente quando ci sono troppi settori invalidi. Si tratta di  
	 un compito comune e necessario.
•	 Aspettare alcuni minuti o proseguire il lavoro a questa condizione speciale.

12.7. Ripristino dello strumento
Se il visualizzatore non reagisce, effettuare un ripristino per correggere il problema. Premere e 
mantenere premuto il tasto di accensione e spegnimento per circa 20 secondi. Aspettare circa 
5 secondi e premere nuovamente il tasto di per accendere il visualizzatore.
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